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Legal Statement  
Copyright © 2010 Hawker Beechcraft Corporation. All rights reserved. Hawker and Beechcraft are 
trademarks of Hawker Beechcraft Corporation. 

All trademarks are the copyright of their respective owners.  

WinView, WebView and LinkOne are registered trademarks of Mincom Limited.  

Microsoft, Windows and the .NET Framework are registered trademarks of Microsoft Corporation. 

Disclaimer and Limitation of Liability 

Every effort has been made to ensure the accuracy of this IML Viewer reference documentation. Hawker 
Beechcraft makes no warranties of any kind (whether express, implied or statutory) with respect to the 
information contained herein. Hawker Beechcraft assumes no liability to any party for any loss or damage 
(whether direct or indirect) caused by any errors, omissions or statements of any kind contained in this 
software documentation. Further, Hawker Beechcraft assumes no liability arising from the application or use 
of the product or service described herein and specifically disclaims any representation that the products or 
services described herein do not infringe upon any existing or future intellectual property rights. All rights and 
privileges related to any intellectual property right described herein are vested in the patent, trademark, or 
service mark owner and no other person may exercise such rights without express permission, authority or 
license secured from the patent, trademark, or service mark owner. Hawker Beechcraft reserves the right to 
make changes to any information herein without further notice. 

Technical Publications 
Hawker Beechcraft Corporation 
10511 E. Central 
Wichita, Kansas 
67201-0085 USA 

Information 
For the latest Interactive Maintenance Library Viewer Software information, upgrades, documentation and 
tips, please visit the IML Support Website 
http://www.hawkerbeechcraft.com/customer_support/technical_publications/iml_support/ 

Installation – System Requirements - Configuration 
Installation and System Requirement Configuration details are available as a separate Installation Guide on 
the IML Support website in the Downloads section.  

Getting Started with IML Viewer  
The following is an overview of IML Viewer functionality and how to start using it quickly and easily. We 
encourage all users to make use of the integrated help to access detailed information inside IML Viewer. 
Press F1 when running the program to access this feature.  

NOTE: The integrated help covers some features that may not be activated in your HBC customized Viewer. 
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Accessing Your Data CD 

1. Insert the Data CD into the CD-ROM drive of your computer, and allow the computer enough time to 
recognize the CD.  

2. Close the Auto-play dialog box that generally opens when your system recognizes the presence of a 
CD. 

3. Double Click the IML Viewer Shortcut  placed on your desktop during installation. The Viewer 
opens the Hawker Beechcraft Interactive Maintenance Library Main Menu.  

Main Menu Tour 

 
Figure 1 - IML Main Menu 

4. Click desired Model. The Model Menu opens to display a list of the Manuals (Books) available. 

5. Click the Manual desired. 

6. Click the Chapter. 

7. Click the desired Topic listed in the Linked Table of Contents for that Chapter. 
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Table 1 – IML Main Menu Left Window Map 

Software Support 

Helpline Support 
Call the toll-free number anywhere in the Continental United 
States or dial the direct number. The Help-Line is open 8:00 AM 
to 4:30 PM Central Time Zone. Leave a voicemail if calling 
outside of the stated hours. 

Email Support 

Click the Email Link to send an email direct to the Help Line 
Technicians. See the Contact Us Section in Appendix 1 for 
instructions on what to include in an email or voicemail contact. 

IML Software Support 

Direct Link to the IML Software support website. 

CD Status 

Check this link when you need to know if the data CD you have 
is current. The report details the release date and revision of the 
current CD. It also lists individual manual titles, part numbers, 
revised/reissued numbers and dates; software corrections. 

Web Sites Links 

Hawker Beechcraft Corporation: Main Corporate Page 

Online Service Information: Communiqués, Service Bulletins 

Online Kit Catalog: Searchable Database 

Technical Publications: Order Publications Online 

Buy Parts: Hawker Beechcraft Parts and Distribution 

 
 

Customizing the IML Viewer  

Testing and customer consultation has resulted in an IML Viewer 5.x that is designed specifically to meet the 
needs of our Hawker Beechcraft Customers. 

Although there is customer leeway in changing some settings, we recommend you leave the scheme as it 
has been set for you. In some cases, changing the settings may result in unfavorable Viewer behavior.  

Features that you can safely customize include:  

 Where to look for books if you have chosen to image your CDs to the computer hard drive or a network 
drive. The Book Mapping Procedure is included in the Libraries section of the Configuration Menu. 

 Parts List Items that have notes against them can be indicated by an icon or Highlighted. The default 
setting is the Icon.  
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How to Access the Configuration Menu  

1. Click Tools from the main menu bar 

2. Left-click on the Configuration… pull down menu option. The Configuration dialog opens.  

 
Figure 2 - Accessing Configuration Screen from Tools menu 

Using the Configuration dialog  

The configuration manager window is split into two separate areas. The left side lists Viewer functions that 
can be configured. for each area. The right side displays the configuration options for the currently selected 
item in the list. 

 
Figure 3 - Picture Configuration Window 

After you have finished configuring the IML Viewer, click OK to save changes.  

Licensing  

The Viewer License allows you to read books from Hawker Beechcraft Corporation’s Interactive Maintenance 
Library. The License is automatically installed with the IML Viewer. 

Security Keys  

Security keys for most manuals are no longer required by HBC. The installation of Viewer 5 still includes 
security keys. However, if you receive a “You are not authorized to read this book” message, please call the 
IML Help Line.  

Adding Security Keys  

Some IML Manuals remain restricted until revised, and require a security key to view the content. To add a 
security key license to IML Viewer, open the Configuration dialog and select Licenses in the configuration list 
on the left side of the Configuration window. 
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Figure 4 - Licenses: Security Key Entry 

 To add a security key, click the Add button  from the toolbar which will open the Add License box.  

 To edit a license, select it from the grid and double click the security key or click the Edit button . This 
will open a license text entry box allowing you to change the license key.  

 To delete a license, select it from the grid and click the Delete button . The license entry will be 
removed from the grid.  

 Click OK to save your changes. 

If you receive a security key, copy the license to the clipboard and paste it into the License Code text area. 
Click OK to add the security key to the licensing grid.  

 
Figure 5 - Add License Dialog 

Copying Books onto a Hard Drive or Network Server 

General  
If you wish to operate Interactive Maintenance Library (IML) Data CDs without having to insert and swap CDs from your 
CD-ROM drive, you will need to copy each data CD to your hard drive (or network drive) then map the IML software to 
access the files. Procedure for Mapping follows this section.  
 
This document assumes you have downloaded and installed the IML viewer from the IML Software Support download 
section according to the stated guidelines.  

Initial Copy onto Hard Drive (or Network Drive)  

Use this procedure to image a CD for the first time to a local hard drive, or to a Network drive. If you are updating a IML 
CD that already exists on your hard drive, skip this procedure and complete the ‘Update existing data files when a CD 
gets revised’ procedure.  
 

1. Create a separate for directory for each CD you wish to copy to the hard drive.  
 

Examples:  
C:\IML Data\Beechjet  
C:\IML Data\Premier  
C:\IML Data\Hawker  
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2. Insert the IML CD into the CD-ROM drive.  
3. Using Windows Explorer, drag and drop the directory named “Books” from the CD-ROM drive to the appropriate 

folder created in step 1 (i.e. Beechjet, Premier, Hawker, etc.). Most CDs contain approximately 600 MB of data 
and can take up to 30 minutes to copy.  

4. “Point” the IML software to the new location using the Configuration Manager within the IML Viewer:  
a. Open IML Viewer 
b. Click Tools and select Configuration. . . 
c. Select Libraries in the left pane of the Configuration Window. 

d. Click the Green Plus sign  above the Libraries pane on the right. 
e. Browse to select the folder that the data was copied to, (above).  
f. Click to select the “Books” folder, and then click OK.  
g. Click OK. The new library will be added to the bottom of the Libraries list.  

Update existing data files when a CD gets revised  

Use this procedure to update files when a revised CD arrives and the Maintenance Manuals have been copied to a local 
hard drive, or to a Network drive.  
 

1. On the destination drive, locate the directory that contains the older data. For example: KingAir200.  
2. Rename the directory so it includes the word “old” (without quotes). For example: KingAir200_old.  
3. Create a new directory with the same basic name as the original one (above). In this example, KingAir200.  
4. Copy the Books folder and all of its contents from the CD into the new directory.  
5. Run the IML Viewer and randomly access a few Books. This makes sure the new files can be located and 

accessed by the Viewer.  
6. Delete the original folder (in this example, KingAir200_old) and all its contents.  

Establishing Hierarchy via IML Administration  

Leave the C:\Program Files\HawkerBeechcraft\IML\Menu, D:\books, E:\books At the top of the Library.  
 
The IML software searches for the data in the top down order it finds the mapped books in the Active Libraries and Books 
window. This is only an issue when a user has more than one library that shares common manuals. This is occasionally 
an issue if for example, you have several Hawker data CDs imaged and a shared manual such as the Overhaul Manual 
is revised – If you don’t update all of the data for each Hawker Model then the viewer could access an outdated shared 
manual if it finds it first in the Libraries folder List.  
 
For example: The library list in the Configuration Manager below has the earlier 125-1 Hawker ahead of the 
800850xp\Books. They share a common Overhaul Manual. If the Overhaul manual was revised and you update the 800 
Series CD but not the 125-1, then the IML Viewer would find the outdated 125-1 Overhaul Manual in the 125-1\Books 
location first and open it instead of the latest revised version located in the 850xp. It is important when having multiple 
model CD images to keep this in mind. 
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Mapping the Viewer (Adding Local Libraries) 

The IML Viewer Software will acknowledge an IML Data CD as long as the CD is inserted and recognized by 
your computer before the IML Viewer is opened. If the path to your CD drive, hard drive, or network is lost by 
the IML Viewer, select Libraries from the configuration window to remap the drive. This will open the 
Libraries application in the configuration window.  

 
Figure 6 - Add Libraries 

How to Add, Remove or Disable a Library  

1. From the libraries configuration window, click the Add Library button . 

2. A folder browsing dialog will be shown. Select the folder where your Viewer library is located and 
select the Books folder. Then click OK.  

3. You will now see your library under the All Libraries folder in the Libraries window.  

 You can expand a library to see which books are available from that library.  

 To remove a library path, select the library from the list, and click the Remove Selected 

button . 

 To disable/enable a library, select the library from the list, and click the Disable/enable 

Library button .  

Restoring IML Viewer Configuration Default Settings 

If you have customized the viewer and are missing toolbars or windows you can’t restore, please call the IML 
Helpline.  

The IML Viewer User Scheme  
The IML Viewer window contains a number of main controls such as: 

 Table of Contents (or TOC) 

 Text – Where Interactive and PDF documents appear. 

 Shopping Cart – Interactive with Parts and Wiring Catalogs (Does not interact with PDF 
catalogs). Sometimes referred to as Selection List.  

 List Notes – Visible when a private or public note has been created against a page or book by 
the user. 

 Pictures – Visible when there is a graphic(s) for that page.  

The toolbars have tool buttons placed on them to help you access functionality quickly. 

These include: 

 Navigation 
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 Pictures 

 Search 

 Navigation 2 

 Filter 

 
Figure 7 - Viewer User Interface  

We recommend leaving the Control windows and toolbars as placed by the customized Viewer Installation.  

Each control can be undocked and placed anywhere within the Windows desktop. Undocked controls may 
be placed at the edge of the IML Viewer window or another docked control. Controls may also be hidden. 
Clicking or hovering the mouse on a small tab on the edge of the IML Viewer window will show docked 
controls. 

Toolbars and Command buttons  

Toolbars contain command buttons that are shortcuts to common functions provided by the IML Viewer.  

Table 2 - Navigation Toolbar 

Button – (Keyboard Shortcut) Description  

 (F12) History – Back  Goes back one step following the path you took to 
get there.  

 History - Forward Goes forward one step in history.  

 Main Menu Goes back to the IML Main Menu. 
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Button – (Keyboard Shortcut) Description  

 (Ctrl+T) Show/Hide TOC Shows or hides the Viewer built-in Table of 
Contents control.  

 Chapter TOC Opens the Chapter page of current page. 

 (Page Up) Previous Page  Opens the previous page in the manual.  

 (Page Down) Next Page  Opens the next page in the manual.  

  Go back to the Start of the 
Current Book 

Returns you to the Manual Menu. 

Toolbars and command buttons can be customized using the Toolbar Customization dialog, found by right 
clicking on any toolbar and selecting the Customize menu item. Command buttons can be added and 
removed quickly by holding down the ALT button on the keyboard and dragging the button to another toolbar 
or menu.  

To restore any closed toolbar or control to it’s default condition, right click on any open toolbar and select the 
Customize menu item. Click on any closed toolbar from the list to open it. Dock the opened toolbar to a 
desired location. If you select Lock the Toolbars, there is no easy way to Unlock them.  

 

Figure 8 – Icon’s in the View Shortcut Menu access windows. 

Version 5 Viewer Controls compared to Version 4 Windows 

The table below compares the controls in Version 5 viewer software with the naming convention and 
description used in Version 4 viewer software.  

Table 3 - Software Version Comparison 

Version 4 Window Version 5 Control Function 

Table of Contents Icon Table of Contents Tab Default is un-pinned Tab. When mouse hovers 
over the tab the entire Book’s Table of Contents 
is displayed. 

Text or Parts Window Text Window Displays Interactive Text, PDF Documents and 
Parts Lists 

Notes Window is unlabeled 
but window is visible when 
there is a note available. 

List Notes Control Displays Public and Private Notes made by the 
user for that page.  

Graphics/Picture Window is 
unlabeled.  

Pictures Control Displays Figures associated with that page. 
Version 5 centers the figure in the window. 
Topics without pictures do not display the picture 
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Version 4 Window Version 5 Control Function 

window but span the text window the width of the 
screen. 

Selection List Shopping Cart Tab User adds parts to the shopping cart from 
Interactive Parts and Wires Catalogs.  

Docked controls can also be pinned  or un-pinned . When a control is pinned, it will stay visible 
inside the IML Viewer interface. If a control is un-pinned, it will be hidden and accessible by a tab docked on 
an edge of the IML Viewer application. If you use the mouse to hover over and click on the hidden tab, the 
control will show itself again. You can pin/un-pin a docked control by clicking on the pin icon on the title bar 
of the control.  

The Built-in hidden tab for the TOC is located on the left edge. The Shopping Cart hidden tab is on the 
bottom left. 

Pictures Control  

From left to right: 

  
Previous Picture (F5); Next Picture (F6); Fig Number and Title; Pull-down arrow for Figure Selection List; 
Zoom…, Rotate Clockwise (Right), Rotate (Counterclockwise) Left, and Mini-Map. 

The pictures window displays graphic/figures which are part of the currently viewed page. You have the 
ability to pan around a picture by holding the right mouse button while dragging the picture around the 
window. You can zoom in by holding down the left mouse button and drawing a box (rubber-band zoom) 
around the area you wish to enlarge. 

 

Figure 9 - Picture with rubber-band zoom. 

After Zooming the picture, Right clicking restores the picture to the default ‘Fit-to-window’ view.  

How to Zoom in on a Picture  

1. Left-click on the picture and hold the mouse button down.  
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2. Drag the mouse to create a zoom 'rubber band'.  

3. Release the mouse button to zoom into the picture.  

 Alternatively, you can click anywhere on the picture and use the mouse-wheel to zoom in 
and out of the picture.  

 You can also change the zoom level by selecting an option from the zoom combo box.  

Once the picture is larger than the viewable area, you will be able to pan around a picture, thus changing the 
location of the scrollbars and navigate around the picture easily.  

How to Pan a Picture  

1. Right-click on any point on the picture and hold the mouse button down.  

2. Drag the mouse in the opposite direction to which you wish to pan the picture. As you move the 
mouse, the picture will scroll with the mouse movements.  

3. Release the mouse button to stop panning.  

The MiniMap  

A MiniMap provides a full view of the currently viewed picture in a small window that can be repositioned 
anywhere on the picture control. It can be resized and will always show the complete picture. When the main 
picture is zoomed beyond the outer edge of the MiniMap, a green rectangle will show around the viewing 
area of the main picture.  
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Figure 10 - Picture Control with Mini-map  

To show or hide the MiniMap click the command button that resides to the left of the zoom combo box. 
Clicking on any point on the MiniMap will center the viewing rectangle at that point on the main picture. You 
can also left-click and drag the mouse cursor around on the MiniMap, which will then pan the picture.  

 

Figure 11 - Show/Hide mini-map button  

List Notes Control 

IML Viewer default scheme displays the List Notes Window.  

Text Window 

The Text Window in Parts Catalogs display parts list information or embedded documents (e.g. - PDF, 
Interactive documents and/or HTML pages). If you click on a callout on the Figure, the corresponding entry in 
the parts list is highlighted. Conversely, selecting an entry from the parts list will highlight that callout on the 
figure. 
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Figure 12 - Text Control displaying an Interactive Parts List 

Right clicking on a parts list opens a context menu which provides access to common functions as well as an 
option to show a toolbar on the control. The context menu options are the same as those which appear on 
the toolbar.  

 

Figure 13 - Parts List Menu  

Navigating an IML Book using the Built-in Table of Contents Control (TOC) 
In addition to using the Interactive customized HBC menu system you may also use the Viewer’s built-in 
TOC. Once you have opened an IML book, the Table of Contents control lists all of the pages inside the 
book in page order. Clicking on a page will open it in the viewer text control window.  

Table of Contents Control  

The table of contents control lists the pages contained in an IML book. By selecting one of these entries, IML 
Viewer will load that page's contents into the viewer. Each entry in the table of contents contains the page 
title, and/or the page number/reference. If a page contains child pages, an plus sign icon will appear beside 
the page entry. Clicking the plus sign will expand or collapse its child pages. Chapter Listings contain child 
pages of the contents. 
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Figure 21: Table of Contents - Hierarchy Mode  

Right clicking on the table of contents control opens a menu which provides access to common TOC 

functions. Click the Toolbar  to display the Table of Contents Toolbar at the top of 
the TOC control window. 

Table 4 - TOC Toolbar Icons/Description 

Button  Function  

 Save TOC Saves the Table of Contents tree to a CSV file.  

 Expand Everything Expands the table of contents tree.  

 Collapse Everything Collapses the table of contents tree.  

 Page Order Default View: Page Order.  

 Hierarchy Order Not Recommended: Switches view to Hierarchy Mode.  

 Find Previous 
Position 

Disabled: Finds the previous position of the current page in the hierarchy.  

 Find Next Position Disabled: Finds the next position of the current page in the hierarchy.  

 Book Information Disabled: However, holding your mouse pointer over the grayed out icon shows 
a Mouse over tip that Displays the number of pages listed in the TOC.  
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Figure 14 - Built-in Table of Contents on the Left – Book Menu Style TOC on the right 

Parts and Wiring Diagram Manual Text Window and Table of Contents 

Interactive Parts/Wires Catalogs do not have the standard chapter TOC. The Chapter Table of Contents are 
indentured as illustrated: grey shaded arrows indicate a link to that figure. Subject Titles organize the linked 
figures for that subject. 

 
Figure 15 – Typical Parts Interactive Chapter TOC 

The Parts list may also have built-in links to another figure. The grey shaded arrow indicates a link from that 
part to a related location in the parts catalog. Double click on an item that has a grey arrow to jump to the 
related location. 
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Figure 16 - Linked Part  

Built-in Portable Document Reader (PDF)  

Previous Viewers were dependent on Adobe Reader. Viewer 5.x has a proprietary PDF reader to display 
PDF Books and does not access Adobe Reader.  

 
Figure 17 - PDF Reader Environment 

When you open a manual in a PDF format, the Viewer invokes the built-in PDF Reader and displays the 
page in the Text Control Window. If the PDF has been Bookmarked the Bookmark icon will be available. 
Click the bookmark icon to display the bookmark panel to the left of the Text Window.  

Notice that this illustration has the Built-in TOC pinned which anchors the TOC in the open position. The 
Built-in Viewer TOC is an easy way to move from place to place in a PDF Book without having to page back 
and forth between Menus and Pages or a Chapter TOC. The Built-in TOC can be ‘unpinned’ and reduced to 
TAB access by clicking the push-pin Icon.  



 

Interactive Maintenance Library User Guide 

IML User guide 15 of 36 Rev 1: Sep.09 
  Issued: Aug.08 

PDF Toolbar Features from Left to Right 

  

Figure 18 - PDF Reader Features 

 First Page Left Blue Arrow - will take you back to Page 1 if you are on a page other than page 1. 

 Page forward and Page backward - Use the blue arrows or type the page number directly in the page 
number box to go to a specific page. Right Clicking the Scroll Bar gives you additional options for moving 
around the document. 

 Last Page Blue Arrow - takes you to the end of the PDF document. 

 Zoom in and Zoom out. 

 Fit Width and Fit Height. 

 Single Page View or Double Page View.  

 Rotate Left and Rotate Right changes the page orientation. 

 Bookmark Icon - When grayed out the PDF does not have Bookmarks. When active Bookmarks are 
available within the PDF document.  

 Search Box - Allows you to perform single or multi-word (consecutive phrases) searches. Previous and 
Next Match finds additional occurrences in the document.  

Printing the PDF document 

To Print, click on File > Print on the menu bar and set the Available content to Text in your printers Print 
Dialog Box. Selected text and Zoomed printing are not available in a PDF document. Printing a single page, 
the entire document or a range of pages are available print options.  

PDF Hyperlinks 

Text highlighted in blue on the face of a PDF document indicates a Link to that section. Some Links on List 
of Publications pages are not blue. Move your mouse over the List of Publications table of contents. If there 
is a link to that section, the mouse with turn into a pointy finger.  

Depending on how the link was originally created, the link may not be active. In this case open the 
Bookmarks or the Built-in-TOC to move around the document.  

Shopping Cart (Selection List) Control  

The Shopping Cart allows you to add or remove items from an IML Parts Catalog which can be exported to 
different files. Double clicking on an entry in the parts list or the figure will add the part information to the 
selection list in the shopping cart. You can also add blank entries to the selection list and edit the information 
yourself.  

 

Figure 19 - The Shopping Cart Control  

The Fields in the Shopping Cart are customized according to the type (Parts or Wires) of catalog or manual. 
You can edit the fields that have a box around them.  
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Table 5 - Shopping Cart Field Descriptions 

Field Description Can Edit 

Catalog 
Each Manual/Catalog is assigned a Descriptive Book code that 
appears in this field. 

- 

Part Number Part Number pulled from the Part Number Column. Yes 

Description The first line of the description for the part. - 

Qty The Qty needed. Yes 

Figure Num Figure Number. - 

Item Num Item Number assigned to that part. - 

Units Not used. - 

Comments 
Use this field to enter additional lines of the description or 
instructions, etc… 

Yes 

The Shopping Cart has its own toolbar and short-cut menu which provide access to common shopping cart 
functions. Right Click the Shopping Cart window to display the shortcut menu. The shortcut menu provides 
additional functions for saving, exporting or printing the shopping cart. 

 

Figure 20 - Shopping Cart toolbar  

Button  Description  

 Go To 
Highlights the part in the parts list that is currently highlighted in the shopping cart list. If 
this part exists in another book location IML Viewer will open the viewer to that location 
and highlight the part in the Parts List and Figure. 

 Add Blank Entry Adds a new blank entry to the Shopping Cart.  

 Edit Current Entry Edits the first editable field in the highlighted item of your Shopping Cart List.  

 Remove Selection Deletes the highlighted Shopping Cart entry.  

 Print Shopping Cart Prints the current Shopping Cart.  

 
Selection Display 
Format 

Opens a sub-menu displaying the available display formats to use when displaying the 
Shopping Cart List. Always use the IML Shopping Cart format. 

 Select Print Format 
Opens a sub-menu displaying the available print formats. Always use the IML Shopping 
Cart format.  

Notes  

An often overlooked feature of IML is the ability to post a “yellow sticky note” to any page or menu in an IML 
book. There are two classes of notes, Private and Public. By default, Private notes reside on your 
computer’s hard drive. Public notes usually reside on a network drive and are intended for everyone to see. 
A public note is an efficient way to make critical information available to all users of IML within your 
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organization. You create Public notes in the same manner as Private notes except that you must first create 
a public note folder on your network’s server and tell the IML viewer where the folder is. 

Setup Location for Public Notes and Public Bookmarks 

1. Using Windows Explorer, create a folder on the network drive where the notes are to be stored. This 
folder must have read privileges for notes to function. 

2. Click Notes on the Menu Bar and select Configuration.  

3. Scroll the left pane of the configuration dialog to Notes and select Folders. 

4. In Public Notes Folder box, enter the file path or browse to the folder location created in step 1. 

5. Press the OK button. 

NOTE: Each person connected to the network must perform steps 2 thru 5 to have access to the public 
notes. This will update the IML initialization file with the path to the public notes folder.  

IML Viewer notes allow a user to store and review information inside the viewer. Notes can be created using 
the Notes dialog which is accessed from the Notes menu. Select the Notes... menu item.  

The notes dialog box is split into two main sections. The left side is a sorted list of notes currently accessible 
to the viewer. The right pane displays the information about the currently selected note. The right pane will 
change depending on the type of note selected in the list.  

 

Figure 21 - Note Manager  

IML Viewer provides a number of note types which vary in functionality. The note types and a description are 
given in the table below.  

Program Note A program note allows you to link to an application such as Word, PDF Document, 
Excel or some other document within the page. 

Cross Reference Note A cross reference note allows you to create a link between two IML books, pages, 
picture or parts list items.  

Text Note A text note allows you to store text that opens in a note viewer when activated.  

Hyperlink Note A hyperlink note is used to create a hyperlink to a website.  
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Editing / Deleting Notes  

Click Notes on the Menu Bar and select Notes… from the dropdown list. Select th desired Note you wish to 
Edit from the Notes List. Note Details will display in the right section of the Notes dialog. Edit the Note and 
click OK to save changes. To delete the note, click the delete icon from the Notes toolbar. The notes toolbar 
provides access to note functions as well as customizing how notes are sorted and displayed.  

Table 6 - Notes Toolbar Description 

Button  Description    

  Add Note Adds a note to the note collection.  

  Add Translation Currently Disabled: Adds a note translation to the currently selected note in the list.  

  Delete Note Deletes the currently selected note. 

  Sort By Determines how categories will be sorted and displayed. Available options are;  

Name - sorts categories alphabetically by their name. (Default setting) 

Access -groups categories into their respective access modifier groups and then 
sorts them alphabetically within these groups.  

Location -groups categories into their respecting location modifier groups and then 
sorts them alphabetically within these groups.  

  Undo Changes Reverts notes to last saved state. Any changes made to any notes in the dialog that 
happened after the last save will be undone.  

  Show/Hide 
Details 

Shows or hides the notes details window.  

  Execute Note 
Action 

Executes the currently selected note.  

Creating Notes  

To create a note, click on the Add Note button and select the type of note you wish to create. A new note of 
that type will appear in the note list, and the note window will open a blank form. Once you have entered all 
required information, Click OK to save your note changes.  

If the OK button is disabled, there is incorrect or missing information in one of the notes that is being 
currently edited. Incorrect or missing information is highlighted by an attention icon next to the field which 
needs to be altered so the note can be saved. Clicking Cancel will discard any changes made to notes since 
the last save and close the notes window.  

Parts List Item Notes 

Notes may be added to a parts list by right clicking on any entry and selecting this option from the drop down 
menu.  

Select an Item and right click your mouse. A short cut menu displays. Select Text Note. The Text Note dialog 
window opens.  Add your comments and click OK. 



 

Interactive Maintenance Library User Guide 

IML User guide 19 of 36 Rev 1: Sep.09 
  Issued: Aug.08 

 

Figure 22 - Parts List Context Menu  

The Description will have a path to the Item. Replace this Description with your own short title description. 
For example, Description for an item specific note may consist of ‘Item 145 – Your Own Short Title’. The 
Association for the Item is already selected. Change the Access to Public if you want others to be able to see 
the note. Set the Category and check ‘Include in List Notes’. Type the Information about the part in the 
Annotation Window.  

Version 5 has incorporated additional text flexibility such as font size, bold, italic, underline, color, bullets, 
numbered list, font and background color, etc. IMPORTANT: Remember to Click OK when you are finished 
or the note will not be saved! 

 
If an item in the parts list has a note associated with it, a small note icon will display in the first column. A tool 
tip will display a Title/Description if you hover over the note with your mouse. Double-Clicking a note icon will 
execute that notes action (i.e. Open the Text note for viewing or follow a hyperlink to another location).  

 

Figure 23 - Parts List Tooltip on Note  

The Notes Explorer  

The notes explorer dialog allows you to view all note types that are available from your current position in an 
IML book. This dialog is very useful if there are a large number of notes and you wish to find a certain note to 
view. Using the notes explorer dialog you can also delete notes that are no longer required which is valuable 
when maintaining notes which are shared by a large number of users.  
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Figure 24 - Notes Explorer  

Bookmarks  
An Interactive Maintenance Library (IML) bookmark is used in the same manner as a bookmark in a paper 
manual to easily find an often used page. A bookmark can be active to one or all of your IML manuals and 
behaves as a hyperlink direct to the bookmark. If you operate IML from a network you can also make 
bookmarks active to other IML users on the network. 

Creating Bookmarks 

1. Open the manual to the location you want to bookmark. You can also place a bookmark on a menu 
page. Whatever is showing when the bookmark is created is the place that will be bookmarked. 

2. On the upper IML tool bar select Bookmarks. 

3. Then select Create Bookmark…  

4. The Bookmark control window opens to the Direct Tab. 

5. Replace the ‘path’ information that is auto-inserted in the Name box with a short but descriptive title, 
i.e. “900XP Main Gear Removal”. It is important to give the Bookmark a recognizable title since this 
title displays in the Bookmark list.  
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Figure 25 - Bookmark Control Window 

6. Publisher, Book, and Reference data are automatically set to values of the book (IML manual) that 
you have open.  

7. Item: Is used in Illustrated Parts Catalogs and Wiring Diagram Manuals to bookmark a specific item 
number. If you have highlighted the item in the Parts List you want to bookmark, before you opened 
the Make Bookmark dialog box, the item number will be automatically filled in for you. For Wiring 
Diagram Manuals, the Reference Designator number is used. Otherwise you can enter the item 
number, i.e. “110” in the Item box. 

 
Figure 26 – Bookmarked Selected Part in Parts List 

Parts/Wires Bookmarked Part List Items are highlighted and takes you directly to that item in the Parts List. 

8. Comments: This is an optional field to add clarifying statements to the bookmark. Comments are not 
displayed when using a bookmark. They are accessed only by “Editing” the bookmark (See Editing a 
Bookmark below). This field might be useful in Global bookmarks to note the date of creation and the 
person who created the bookmark. 

Access:  

Select “Public” or “Private” radio button as appropriate.  

 “Private” makes the bookmark accessible only to the computer it was created on.  

 “Public” makes the bookmark accessible to all IML users on a network. 

NOTE: See ‘Setup Location for Public Notes and Public Bookmarks’ procedure. 

Location:  

“Book” makes the bookmark active only when the selected book is active. 

“Publisher”: Do not use. 
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“Global” makes the bookmark active in all IML books and menus. 

9. Select “Book” or “Global” 

10. Click OK if you are satisfied with the bookmark. 

Managing Bookmarks 

Direct bookmarks point directly to a book, page, or entry list. Via Bookmarks are bookmarks that point to 
previously created bookmarks.  

 Bookmarks are managed by the Bookmarks dialog which is accessed by opening the 
Bookmarks menu and selecting the Bookmarks... menu option.  

The bookmarks dialog is split into two main sections, the bookmark list contains a sorted list of all 
bookmarks, and the details section displays information about the currently selected bookmark.  

 

Figure 27 - Bookmarks Dialog  

Editing Bookmarks  

The bookmarks dialog contains a toolbar which allows you to add, edit or delete bookmarks. The toolbar also 
allows you to change how bookmarks are viewed in the Bookmarks dialog.  

Button  
Description  

 Add Bookmark Adds a bookmark to the bookmark list.  

 Add Translation Currently Disabled: Adds a translation for the currently highlighted bookmark. 

 Remove Bookmark Deletes the currently selected item in the bookmarks list.  

 Sort By 

 Determines how bookmarks will be sorted and displayed. Available options are;  

 Name - sorts bookmarks alphabetically by their name. 

 Access -groups bookmarks into their respective access modifier groups and then sorts 
them alphabetically within these groups.  

 Location -groups bookmarks into their respecting location modifier groups and then sorts 
them alphabetically within these groups.  
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Button  
Description  

 Edit Bookmark 
Bookmarks > Select Bookmark from list that you want to Edit and then make changes to the 
Bookmark displayed in the Bookmark dialog right window. To save changes, click OK.  

 Undo Changes 
Reverts bookmarks to last saved state. Any changes made to any bookmark in the dialog that 
happened after the last save will be undone.  

 Show/Hide Details Shows or hides the details window in the bookmarks dialog.  

 Go to Bookmark Opens the currently selected bookmark in the bookmarks list.  

Using a Bookmark 

1. On the upper IML tool bar click on Bookmarks 

2. Bookmarks will be listed 

3. Click the bookmark you wish to go to. 

4. Bookmarks will always open to the top of the page they are referencing. 

NOTE: “Book” bookmarks can be selected from anywhere within the manual where it was created. 
“Global” bookmarks are available and can be selected from anywhere within the IML Viewer. 

Searching  
IML Viewer provides book search functions. The searches available to a specific book type appear in the 
Search Menu pull down list.  

In searching Parts Numbers or Descriptions, the old adage, “Less is More’ often applies. If you know part of 
a part number, that partial number can be entered and the search will find all instances of that partial string of 
characters. Using a partial search is especially useful if a ‘full-part number search is fruitless. If the search list 
is too expansive, add additional characters/numbers to the search to narrow the results. 

The types of Searches available in IML are as follows: 

Text/Documents:..................One Keyword Only Text Search.  

Page Titles: ..........................Single keyword search of any manual’s Main Table of Contents. 

Part Number: .......................Searches the Part Number field of the Parts List. 

Part Description: ..................Searches the Description field of a Parts List. 

Part Number/Description: ...Built-in on the menu’s for Interactive Parts Catalogs and some Wiring Diagram 
Manual Menu’s. You can search single words or multiple words. Multi-word 
searches have to be an adjacent ‘phrase’. For example, the words landing and 
tire will not be found, but it will find instances of the phrase landing gear. 
Searches both the Part Number field and the Description Field in the Parts 
Listing. 

P/N – Description – Wiring Ref Designator: Search looks in all 3 locations. 

The table below illustrates the type of Searches available in various document formats.  

Table 7 - Types of Searches 

Document 
Format 

Menu 
Search Box 

Page 
Titles 

Documents Part 
Numbers 

Part 
Descriptions 

Wiring Ref 
Designator 

Built in 
PDF 

Search 

Interactive Books Text Search   N/A N/A N/A N/A 
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Document 
Format 

Menu 
Search Box 

Page 
Titles 

Documents Part 
Numbers 

Part 
Descriptions 

Wiring Ref 
Designator 

Built in 
PDF 

Search 

Interactive Parts 
Catalogs 

P/N and 
Description 

     N/A 

Portable 
Document 
Format (PDF) 
Text-based PDF 

Not 
Available 

Not 
Available 

Not 
Available 

Not 
Available 

Not 
Available 

Not 
Available 

 

Scanned PDF 
Documents 

Not 
Available 

Not 
Available 

Not 
Available 

Not 
Available 

Not 
Available 

 Not 
Available

Interactive 
Wiring Catalogs 

P/N-Desc-
Ref 

Designator 

 Not 
Available 

  N/A: Use P/N-
Desc-Ref 

Desig. Combo  

N/A 

The Search Scope at the bottom of the dialog determines the books searched in. The scope can either be 
the current Book, the current book Category and subcategories, the current Publisher, or a user defined 
selection of Multiple Books.  

 

Figure 28 - Document Search with Results  

Selecting Multiple Books will enable the Books button which when clicked, will open a Select Books dialog 
allowing you to choose which books will be searched.  
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Figure 29 - Select Books Dialog from Multi Book Search  

Once a search is completed, the matching page titles, books (if searching more than one book) and match 
information will be displayed in the search form. Selecting a matching page title will display all the matches 
found on that page in the match information list. By selecting a page, book or match and clicking the Go To 
button, IML Viewer will jump to that position in the book. You can page forward and then back through the 
instances found by using the Previous Search Results and Next Search Results buttons.  
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Windows Search 

Ctrl+F is a standard MS-Windows feature you can use to find a word/phrase in the current text document Ctrl 
+ F will open a Find dialog box. You can use this feature when you are in an IML Text document window.  

1. Click anywhere in the text window  

2. Ctrl+F 3. Type word or phrase you are looking for in the text window and search.  

NOTE: This does not work in Parts/Wires Catalogs, Scanned PDF Documents or find words on Figures 
Search is limited to the interactive text document you currently have active. 

Filtering  
Filtering allows you to filter document titles, pages, and parts to help you navigate through and locate 
information quicker. To open the filter dialogs, select Filter by Serial Number from the Edit menu.  

Filter by Serial Number (EFFECT=) Dialog 

Serial Number Filters apply your serial number to the Effectivities defined for parts catalogs. A Key to the 
Usable On Code for Effectivities on each parts list is located at the bottom of the page. The Effectivities 
specific to your model are defined/described in the Introductions to each manual.  

The Filter by Serial Number box allows you to view and change Serial Number Effectivity in the current book. 
Any changes made to these filters will only affect the view of the current book and the filter will be discarded 
when you start viewing a different book, or you close IML Viewer. Selecting the EFFECT= in the filter list on 
the left side of the screen will load possible filter values into the right side. Selecting or entering a value and 
clicking OK will set the Effectivity filter value.  

The SN= and PSN= are preset defaults and entering information in them will not filter and may cause your 
EFFECT = filter to not function. Do not enter information in the SN= and/or the PSN= filters. 

 

Figure 30 - Filter by Serial Number Dialog 

Do the following to filter a parts catalog for your aircraft: 

1. Click the Filter Button on the Toolbar  
(Alternate Method: Click Edit > Filter by Serial Number…) 

2. Click EFFECT= 

3. Enter your Aircraft Serial Number without spaces in the Serial Number box. 

4. Click OK to set the EFFECT= value. 

The Viewer Status Bar displays the Serial Number you are using to Filter the Parts Catalog.  

  
To change the filter to another aircraft: 
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1. Click the Filter Button on the Toolbar  

2. Delete the Aircraft Serial Number in the Serial Number box. 

3. Enter the New Serial Number 

4. Click OK. 

Do the following to remove a filter from a parts catalog: 

1. Click the Filter Button on the Toolbar  
Click EFFECT= 

2. Completely delete the Aircraft Serial Number in the Serial Number box. 

3. Click OK. 

Notice the EFFECT= is no longer visible in the Status bar. 

 

Printing  
Users can print Text, Picture and Text, Selected Text, Shopping Cart list, Parts list, Picture or zoomed area 
of the picture. All printing functionality is provided via a Print dialog that uses your default printer. Users can 
use print layouts to customize the output of printed Viewer content. 

 

Figure 31 - Print Dialog Box 

The Available Content combo box allows you to choose which content to print. Clicking OK will print the 
content to the printer.  
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Appendix 1 – Contacts and Support Details 

Contact Information 

Publishing and IML Support 

IML is easy to use. Help is readily available via a helpline (8:00 AM to 4:30 PM Central time). During off-
hours, leave a voice mail message and your call will be returned within one business day. The IML software 
website provides the following:  

Website: http://pubs.hawkerbeechcraft.com (Click IML Software Support) 

 Current CD Status: Provides a downloadable PDF with Rev Dates and Distribution Dates of CDs. 
 Downloads: Latest Software, Updates with detailed instructions. 
 How-To Documents: Latest information by topic. 
 Submit a Question: Launches an email to IML Software Support.  

 

 
Figure 32 – Auto-Email for Help 

 
To provide efficient responses, as a minimum, please include the following in your email: 
 

 Name and phone number 

 Company 

 Contact Preference (email or call back from the helpline support agent) 

 Airplane Model 

 Manual affected 

 Description of the problem 

 Screen prints can be very helpful 

IML Software Support: 

 Phone: 800.240.2959 or +1-316.676.3053 
 Email: IML@hawkerbeechcraft.com  



 

 II 

Subscription Information 

Technical Manual Distribution Center (TMDC): 

 Phone: 800.796.2665 or +1.316.676.8238 
 Email: TMDC@hawkerbeechcraft.com 
 Website: http://hawkerbeechcraft.com/service_support/pubs/default.aspx 

Technical and Field Support 

Hawker Beechcraft Corporation's technical and field support organization is the largest in general aviation. 
All of our technical team have access to cutting-edge technology and the latest information that are critical to 
properly support your aircraft. 

Technical Support is available 24 hours a day.  

 Phone: 800.429.5372 or +1.316.676.3140 
 Email: rapid_parts@hawkerbeechcraft.com 
 Website: http://hawkerbeechcraft.com/service_support/tech_support/  

Ordering Spare/Replacement Parts 

RAPID's call center is open 24 hours a day, 365 days a year for your convenience.  

  Phone: 877.727.4344 and +1.316.676.3100 
 Email: rapid_parts@hawkerbeechcraft.com 
 Website: Website: http://hawkerbeechcraft.com/service_support/rapid/default.aspx  
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Appendix 2 – Installation Location Details 
The following information is  provided for I.T. Administrators. The C:\Program Files\HawkerBeechcraft\IML 
path and contents should not be moved or renamed.  

IML Viewer Program Files Location 

 

 Bin Folder contains the .NET plug-ins for the Viewer. None of these plug-ins should be manipulated in 
anyway at the folder level or within the Viewer configuration program by users. 

 Defaults Folder contains the default settings and layouts for the customized IML Hawker Beechcraft 
Installation Schemes and Parts Catalog Shopping Cart.  

 Documentation Folder contains the built-in Mincom User guide that can be accessed within the Viewer 
via the Menu Bar > Help > IML Viewer Help. Keep in mind this is the developers Help version and can 
be of some benefit, it does not cover the customization for our customers done by Hawker Beechcraft.  

 Menu Folder contains the customized IML Main Menu. When the Menu has an update the update will be 
placed on the IML Software Support Downloads page on the web. 

 Private Notes Folder contains all of the private notes made by individual users and are available only to 
users of the computer where the Viewer is installed. 

NOTE: Public Notes are generally used for Network users and need to be set up with a network 
location, then mapped using the Viewer Configuration Tool. 

 Both Private and Public Notes, and how to create them, is found in the user guide 
documentation. 
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User Files Location 

All Users 

 
 
The user.config file in the All Users folder contains the configuration preferences as set by the Hawker 
Beechcraft customized installation.  
 

Individual User Profile 

 
 
This user.config file contains the configuration preferences as set by each individual user.  
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